LJRoland

ODELA

3D PLOTTER

MDX-20
MDX-15

USER'S MANUAL

This User's Manual isintended for MDX-20 and MDX-15.

Thank you very much for purchasing the MDX-20/15.

e To ensure correct and safe usage with a full under-
standing of this product's performance, please be sure
to read through this manual completely and store it
in asafe location.

e Unauthorized copying or transferral, in whole or in
part, of thismanual is prohibited.

e Thecontentsof thisoperation manual and the speci-
fications of this product are subject to change with-
out notice.

e The operation manual and the product have been
prepared and tested as much aspossible. If you find
any misprint or error, please inform us.

e Roland DG Corp. assumes no responsibility for any
direct or indirect loss or damage which may occur
through use of thisproduct, regardless of any failure
to perform on the part of this product.

¢ Roland DG Corp. assumes no responsibility for any
direct or indirect loss or damage which may occur
with respect to any article made using this product.

Roland DG Corporation



——  For the USA

FEDERAL COMMUNICATIONS COMMISSION
RADIO FREQUENCY INTERFERENCE
STATEMENT

This equipment has been tested and found to comply with the
limitsfor aClass A digital device, pursuant to Part 15 of the
FCC Rules.

These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated
in acommercia environment.

This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference
to radio communications.

Operation of this equipment in aresidential areaislikely to
cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Unauthorized changes or modification to this system can void
the users authority to operate this equipment.

The /O cables between this equipment and the computing
device must be shielded.

—  For Canada

CLASSA NOTICE

This ClassA digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

CLASSE A AVIS

Cet appareil numérique de |a classe A respecte toutes les
exigences du Reglement sur le matériel brouilleur du
Canada

ROLAND DG CORPORATION
1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN 431-2103
MODEL NAME . Seethe MODEL given on the rating plate.
RELEVANT DIRECTIVE : EC MACHINERY DIRECTIVE (98/37/EC)
EC LOW VOLTAGE DIRECTIVE (73/23/EEC)
EC ELECTROMAGNETIC COMPATIBILITY DIRECTIVE (89/336/EEC)
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To Ensure Safe Use

About AWARNING and ACAUTION Notices

AWARNING

Used for instructions intended to alert the user to the risk of death or severe
injury should the unit be used improperly.

A\CAUTION

pets.

Used for instructions intended to alert the user to the risk of injury or material
damage should the unit be used improperly.

* Material damage refers to damage or other adverse effects caused with
respect to the home and all its furnishings, as well to domestic animals or

About the Symbols

LN

"danger of electrocution.”

The A\ symbol alerts the user to important instructions or warnings. The specific meaning of
the symbol is determined by the design contained within the triangle. The symbol at left means

®

The ® symbol alerts the user to items that must never be carried out (are forbidden). The
specific thing that must not be done is indicated by the design contained within the circle. The
symbol at left means the unit must never be disassembled.

€

The . symbol alerts the user to things that must be carried out. The specific thing that must
be done is indicated by the design contained within the circle. The symbol at left means the
power-cord plug must be unplugged from the outlet.

AWARNING

®

Do not disassemble, repair, or
modify.

Doing so may lead to fire or abnormal
operation resulting in injury.

Do not use with any power supply
other than the dedicated AC adapter.
Use with any other power supply may lead
to fire or electrocution.

Use only with the power cord
included with this product.

Use with other than the included power cord
may lead to fire or electrocution.

@ & O

Ground the unit with the ground wire.

Failure to do so may result in risk of electro-
cution in the event of a mechanical problem.

O

Do not use with any electrical power
supply that does not meet the
ratings displayed on the AC adapter.
Use with any other power supply may lead
to fire or electrocution.

\

Do not use while in an abnormal
state (i.e., emitting smoke, burning
odor, unusual noise, or the like).
Doing so may result in fire or electrical
shock.

Immediately unplug the power-cord plug
from the electrical outlet, and contact your
authorized Roland DG Corp. dealer or
service center.




ACAUTION

O

Do not use with a damaged AC
adapter, power cord, or power-cord
plug or with a loose electrical outlet.
Use with any other
power supply may
lead to fire or
electrocution.

Do not injure or modify the electrical
power cord, nor subject it to
excessive bends, twists, pulls,
binding, or pinching, nor place any
object of weight on it.

Doing so may

damage the

electrical power \q

cord, leading to

electrocution or

fire.

<

When not in use for several hours,
unplug the power-cord plug from the
electrical outlet.
Failure to do so may
result in danger of
shock, electrocution,
or fire due to
deterioration of the
electrical insulation.

When unplugging the electrical
power cord from the power outlet,
grasp the plug, not the cord.
Unplugging by
pulling the cord
may damage it,
leading to fire or
electrocution.

Do not attempt to unplug the power-
cord plug with wet hands.

Doing so may
result in electrical
shock.

Do not allow liquids, metal objects
or flammables inside the machine.
Such materials

can cause fire. %

\/

Install on a stable surface.
Failure to do so

may result in falling //
of the unit, leading s
to injury. é/\/.])

]

Do not touch the tip of the cutting
tool with your fingers.
Doing so may result in injury.

Wear dust goggles and mask during
use.
Cutting dust
may scatter,
causing
bodily injury.

Do not allow children to operate
without adult supervision or operate
within reach of young children.
Doing so may result in injury.




ACAUTION

During cutting or scanning, do not In case of emergency, immediately
place hands near the cutting tool or unplug the AC adapter
the probe.

Doing so may
result in injury.

While the power is on, do not Do not operate if a transparent cover
remove the spindle unit from the is cracked or broken.
carriage. If the transparent

Doing so may cover at the front
resultin or the side of the
injury. unit is cracked,
contact a service
agent
immediately for
repairs.
Store clay out of the reach of Use a commercially available brush
o children. o to remove metal cuttings.

Attempting to use
a vacuum cleaner
to take up metal
cuttings may
cause fire in the
vacuum cleaner.

When you're finished,
wash your hands to
rinse away all _

cuttings. NI



About the Labels Affixed to the AC Adapter and Unit

These labels are affixed to the body of this product and the AC adapter. The following figure describes the location.
V 4
‘Ti"

During cutting or
scanning, keep hands
away from the cutting
tool and the probe.

Rated power supply

Do not use with any electrical
power supply that does not
meet the ratings displayed on
the AC adapter.

Model name

In addition to the AAWARNING and ACAUTION symbols, the symbols shown below are also used.

NOTICE : Indicatesinformation to prevent machine breakdown or malfunction and ensure correct use.

Q‘_
|§ . Indicates a handy tip or advice regarding use.



1 What You Can Do with MODELA

@ Cut material to make a shape

MODELA cuts materials for three-dimensional objects made with software.
You can aso engrave plates using flat line-drawing data.

@ Create three-dimensional data from a shape

MODELA can scan the shape of a solid object and create three-dimensional data.
You can use this data to do things like changing the size or make use of a natural shape as part of another design.

Cutting a

shape

Creating
data from
a shape

Use software to
create a three-
dimensional object.

Enter the parameters
for cutting the three-
dimensional object
(cutting parameters).

Perform cutting.

Finished result.

3D Design €tc.

MODELA Player

’

g \,*\\

Use software design
a line drawing.

Enter the parameters
for engraving (engrav-
ing parameters).

Perform engraving.

Finished result.

Dr.Engraveetc.

Roland MODELA MDX-++ on
Size Tool I Dpt\ons]
Materizl : [Styrenetoam

1]m 2| 3]
LA FLE

Tool 1 hd
2.5D Driver

| 38

>

N

Prepare the three-
dimensional object.

Enter the parameters
for scanning.

Perform scanning.

Finished result.

Cantroller xl

X SCAN PITCH

m -
mm)

Y SCAN PITCH
L 0S0M

Dr.PICZA

Dr.PICZA




2 Check the Included Iltems

AC adapter: 1 Power cord: 1

Sensor unit: 1 (*1) Cap screw M4 x 15: 4

(Two spares)

D

DS
@“\‘?@““’

Front cover: 1 Hexagonal wrench
(size : 3mm) :1
Hexagonal wrench

(size: 1.5 mm): 1

The configuration of the /

MDX-15 differs, but the
attachment method is the same.

Clay: 1 MDX-20/15 User's Manual: 1

Roland software
package: 1

Spindle unit: 1 (*1)

Tool: 1 Set screw M3 x 3: 2
(High speed steel) (One spare)

The shape of the tool may

differ from that below.

)
T

Positioning pins: 3 (*2)
(diameter 3 mm (0.118 in.),
length 20 mm (0.787 in.))
(One spare)

= 3

Double sided tape: 1

(*1) Do not discard the included-item box containing the spindle unit and sensor unit.
It is needed to hold the unused unit while Modela is in operation.

(*2) The positioning pin is used when performing double-sided cutting with MODELA.
For detailed information about double-sided cutting, see “Cutting Tips” in the included CD-ROM (refer to "8 Overview of

the Usage Guides").




3 Part Names

NOTICE Do not touch the wire with the hands.

Except when repacking the unit, do not attempt to move the table or carriage by hand.

In this manual, sections that explain commons points for the MDX-20/15, use only illustrations of the MDX-20. Some details of
the MDX-15 differ from the figure.

Front
Switch Panel

Carriage
MODELING l
MODE LED —|0 MODELING
SCANNING —— —@ SCANNING
MODE LED
STANDBY key —@
VIEWLED —— @

| VIEW

VIEW key

TOOL-UP key

S

Work plate \ \ TOE-
Table \ TOOL-DOWN key —
—
Rear
L
Wire
—
AC adapter jack
— .

Serial connector




4 Setting Up and Connection

AWARNING

Do not use with any power supply

® other than the dedicated AC adapter.
Use with any other power supply may lead
to fire or electrocution.

Do not use with any electrical power

® supply that does not meet the ACAUTION
ratings displayed on the AC adapter. nstall 0l f
Use with any other power supply may lead 0 nstall on a stable surrace.

Ground the unit with the ground wire.

Failure to do so may result in risk of electro-
cution in the event of a mechanical problem.

to fire or electrocution. Failure to do so

may result in falling //
: of the unit, leading e
o Use only with the power cord 0 injury. L — /}]

included with this product.

Use with other than the included power cord

may lead to fire or electrocution.

NOTICE Never install thisunit in any of the following situations, asit could result in damage:
Places where the installation surface is unstable or not level.
Places with excessive electrical noise.
Places with excessive humidity or dust.
Places with poor ventilation, because the MODELA generates considerable heat during operation.
Places with excessive vibration.

Use within atemperature range of 5 to 40°C (41 to 104°F) and within a humidity range of 35 to 80%.

Securely connect the power cord, computer 1/0 cable and so on so that they will not be unplugged and cause
failure during operation. Doing so may lead to faulty operation or breakdown.

Connecting the AC Adapter and Power Cord

Connect in the order of the numbers shown in the figure. AC adapter jack

AC adapter

Power cord

* Do not place any object =~ < _ I
within the area S <




Connecting with Computer

Serial connector

IBM PC or PC compatible

Serial cable
(XY-RS-34 or equivalent)

« If your computer isan IBM PC compatible personal computer, then use an optionally available XY-RS-14/34 cable (or equivalent). A
straight cable such as modem cable will not work.

» Make sure the power to the computer and the MODELA is switched off before attempting to connect the cables.

10



5 Installing the Software

Software That Can Be Used with the MODELA

The Roland Software Package CD-ROM contains many different kinds of software.
You can view the software that can be used with MODELA by displaying the setup menu on the CD-ROM and choosing the model of

MODELA.

See below for overviews and brief description of usage for the software displayed on the setup menu.

Software

Overview

Windows driver

Thisis necessary when sending datato MODELA from a Windows-based program.
If you're using Windows, be sure to install this driver.

MODELA programs

The Windows versions of MODELA Player, MODELA 3D DESIGN, and MODELA 3D
TEXT cannot be set up separately.

MODELA Player

This sets the required parameters for cutting solid objects and sends the cutting data to
MODELA.

This can import not only solid objects created with three-dimensional programs from Roland
DG Corp., but also solid objects created using other commercially available three-dimen-
sional programs (viaDXF or STL).

MODELA 3D DESIGN

Thislets you choose a basic shape such as a cylinder or sphere, and modify it to create a
three-dimensional object.

You can intuitively create solid objects with smooth curves.

You can use MODELA to cut solid objects and save datain three-dimensional DXF files.

MODELA 3D TEXT

This adds thickness to text to create three-dimensional characters.

It's also possible to edit text to make it bold, italic, or the like. You can put abox around text
with just asingle click — a handy feature when making nameplates.

You can use MODELA to cut three-dimensional text and save datain three-dimensional
DXF files.

Virtual MODELA

This simulates tool movement before performing cutting with MODELA.

You can use it to check the finished shape as well as things like whether the cutting depth is
suitable and how much time cutting will take. This can reduce loss for cutting materials and
time.

Dr.Engrave Thisis used to design plates and send the engraving datato MODELA.
You can make large numbers of plates with the same design with high efficiency. You can
use the TrueType fonts registered in Windows as the font style for text. You can even make
stroke fonts from TrueType fonts.
Because you can the outline of an image and convert it to line segments, it's also possible to
include logos for companies or organizationsin the plates you make.

3D Engrave This adds thickness to aflat (two-dimensional) graphic to create arelief (raised engraving).
You can also add thickness to images such as illustrations.

Dr.PICZA This scans the shape of a solid object with MODELA and creates three-dimensional data.

You can use it to rescan a particular portion, delete unneeded portions, cut a scanned three-
dimensional object with MODELA, or save datain any of four file formats, including DXF
and STL.

11



Setting Up the Program

System requirements

MODELA Applications Dr.Engrave 3D Engrave Virtual MODELA Dr.PICZA
Operating system | Windows 95/98/M e/NT4.0/2000/X P
Computer Computer running Windows (Pentium processor or better recommended)
Memory (RAM) 32 MB or more recommended
:gsl:]ezr‘:o‘:';kstsjgctzn 7MB 10MB 10MB 5MB 3MB

Setting Up the Program

If you are installing under Windows NT 4.0/2000/XP, log on to Windows as " Administrators" account.

1

Switch on the computer and start Windows.

Click the drop-down arrow next to [Click here],
choose the model you're using, then click [Install].
If you're using the MDX-20, choose [MDX-20]. If
you're using the MDX-15, choose [MDX-15].

To view the description of aprogram, click thed)
button. To view the manual, click the (Z) button.
(There are manualsin PDF format for the pro-
grams that the (Z) button references. Acrobat
Reader isrequired to view PDF files.)

If there are programs you don't want to install, then
clear their check boxes before you click [Install].

) Roland Software Package Menu

==Roland Roland Software Package

for PICZA, MODELA, CAMM-2, CAMM-3

. Install

Step 1
Click the drop-dawn arrow far [Slick
here] and choose the model name

Step 2
Click [Install]

To wiew the description of a program,

M click the [] button. Toview the manual,
click the [?] button, i
(There are manuals in PDF format for the e
programs that the [7] button references,
Acrobat Reader is required to view PDF
files)

Go to Raland DG Homepage

2

Place the CD from the Roland Software Package
inthe CD-ROM drive.
The Setup menu appears automatically.

The Setup program starts. Follow the messages to
carry out setup and finish setting up the program.

Welcome x|

Ywelcome to the MODELA Setup program. This program will
install MODELA on your computer.

Itis shionaly recommended that you exit all Windows programs
before running this Setup program.

Click Cancel to quit Setup and then closs any programs you have:
runring. Click Next to cantinue with the Setup program.

WARNING: This program is protected by coppight law and
intemational treaties.

Unauthorized reproduction or distribution of this program, or any
pottion of it, may result in ssver civil and criminal penaltiss, and
will b2 prosscuted to the marimum extent possible under lan

Concel |

*  When the setup for one program finishes, the
setup for the next program starts.
In theinterval until the next setup starts, a dialog
box showing the progress of processing is
displayed.

Install |

Wait...

12



The driver settings appear. Check the values, click
5 [Closg], and finish installing the driver.

Settings:[MDX-++]
Fort: COM1
Timeout{seconds}: 3800
Bit per second: | 9600
Data bit B
Paiiy: Nene
Stop bits: 1
Flow conrol Hardware

7 After returning to the menu screen for installation,

click %].

»ftware Paclkage

LA, STIKA, CAMM-2, CAMM-3

- Install

Changing the Port

When al installation finishes, the screen shown
bel ow appears.
Click [Closg].

Install x|

Complete.

Remove the CD-ROM from the CD-ROM drive.

When the driver isinstalled, the port for output from the computer is automatically set to [COM1]. If MODELA is connected to a port other

than [COM1], follow the steps below to change the port setting.

* The explanationsin this section describe operation of the MDX-20. If you're using the MDX-15, then where"MDX-20" appearsin thetext, read "MDX-

15" instead.
<Driver for Windows 95/98/Me>

Click [Start]-[ Settings]-[ Printer] to open the[Printer]
1 folder. Right-click on the Roland MODELA MDX-

20 icon, then click [Properties].

The [Roland MODELA MDX-20 Properties] dialog

box appears.

Open

Fauge Printing
Purge Frint Jobs
Set bz Default

Create Shortcut
Delete
Fename

Froperties

Set [ Transmission retry] to 3,600 seconds. Click the
3 [Port Settings] .
The [Port Settings] tab appears.

Mot zeiected: | seconds

Transmission retry, seconds
Spool Settings.. ‘ Part Settings... J
Ok Cancel | |

Click the [Details] tab. At [Print to the following
port(s)], choose an unused port other than [COM1].

Roland MODELA MD¥-% Properties 21xl

General Details WShanng] Size ] Tool ] Dptions}

([ Foland MODELA MDX k¥

Frint to thy dllowing port:
COM 2 : [CJ nmunications Part] - Add Part..

Lielete Part

Make the settings for the following communica-
tion parameters. Click [OK].

COM2 Properties 2xl

Port Settings ]

Bits per secondt BT

Data bits: |8 <
Parity: [Mone '
Stop bits: |1 <

Flow caontral: |Hardware -

Advanced, | Bestare Defaults |

0K Cancel ‘ ‘
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<Driver for Windows NT4.0/2000/XP>

When you make the settings for Windows NT4.0/2000/X P driver, log on to Windows as "Administrators' or "Power Users" account.

1 Open the [Printers] folder.
Windows NT4.0/2000:
Click [Start]-[ Settings]-[ Printers].

Windows XP:
Click [Start]-[Control Panel]. Click [Printers and
Other Hardware], then click [Printers and Faxes].

Click the [Ports] tab. For [Port], choose an unused
3 port other than [COM 1]. Click [Configuration Port].

> Windows NT 4.0: go to step 4
> Windows 2000/XP: go to step 5

.Z#Roland MODELA MDX- #+ Properties 2x|
Color Management ] Security ] Device Settings ]
General ] Sharing Ports I Advanced ]

\‘g Fioland MODELA MD3. 4

Fiint to the following port(s]. Documents will print to the first free

checked port.

Part | D escription Printer |j
OLPT2  Privter Port

O comM3. Serial Port

O COM4: Serial Port

O comi: Serial Port

COM2:  Serial Port Roland MODELA MDX- , ...
OFILE: it to File

-

Add Part... | Dielete Port | Configure Port.. J

—_— T~

Make the settings for the following communication
5 parameters. Click [OK].

COM2 Properties ﬂﬂ

Port Settings }

Bits per second: | 9600 hd

Diata bite: |8 -
Parity: ’h‘
Stop bits: ’ﬁ
Flow contral: ’m‘

Bestore Defaults
oK Cancel | |

Right-click on the Roland MODELA MDX-20icon,
then click [Properties].

The[Roland MODELA MDX-20 Properties] dialog
box appears.

Open

Set as Defaulk Prinker
Printing Preferences. ..

Pause Prinking
Cancel All Documents

Propetties

Click the port you chose in step 3, then click [Set-
tings].

Ports x|

Ports: =&
COM1:
COM2: J ‘J

14



Application Settings

When you finish installing the applications, continue by making the following settings. Be sure to make the settings before use.
* The explanationsin this section describe operation of the MDX-20. If you're using the MDX-15, then where"MDX-20" appearsin thetext, read "MDX-
15" instead.

@ MODELA Player

Click [Start] and point to [Programs]. From the [Options] menu, click [Machines...].
1 Point to [Roland MODELA] and click [MODELA 2 The [Model Selection] dialog box appears.
Player].
_o Untitled - MODELA Player - MDX-xx (M

File Edit “iew Option Help

=] Programs b =] Accessories 3 |

% Documents @ B Roland MODELA 4 @ 3D Desien Help Layout
[ Setings » HE MS-DOS Prompt & 3D Desien fbstract ,
2) Find b 13 Windows Explorer @ 3dText Help Customer Parameter,
& Help T #y SdText Path Direstion
21 pun &} MODELA Player Help Machines...
= & MODELA Player
[} Shut Down... TF MODELA Uninstall
i Start
Click [MDX-20], then click [OK]. From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.
Machines selection x|
Specifications _._.Unlilled - MODELA Player : MDX-w#
JSA[UDEIELMAJQ] | dsing area w1524 mm File Edit ¥iew Option Help
Proe-300 [CAMM-3] Y 101.6 mm Open Chil+0
PNE-3000 (i3] z B
Feed Rate 01 -15.0 mmds
Z: 01 -15.0 mmds Frirt Setup...

Click the drop-down arrow for the name and click
5 [Roland MODELA MDX-20].
Then click [OK].

Print Setup el |
Frinter
Hatne |no|andMuDEu.\MD><<j > Bropertes
Status:  Ready

Type: Foland MODELA MO+

—
/\—r —_— | — |
Cancel




@® Dr.PICZA

1 Click [Start]. Point to [Roland Dr.PICZA] and click

[Dr.PICZA].
=] Erograms 4 |
2 Documents b (=) Accessoies 4 |
[ih Settings * =) Roland DrPICZA v @& DRIz
2] Eind ¥ (=) Startlp » &} DrAICZA Help
& Heb BE 145003 Prompt W uninstal
3 Bun 3] ‘windows Explorer

g Shut D,
Al Start

Select the port where the cable is connected, then
3 click [OK].

Preferences

v Simple display

W Affix back surface during data output

72l

COMT  COMZ  COM3  COM4

@ Dr.Engrave

Click [Start]. Point to [Roland Dr.Engrave] and click
1 [Dr.Engrave].

= Erograms "
b =) Accessories 4 ‘

=% Documents

i;{; Settings | || Roland Dr.Engrave » Q'f@ Dr.Engrave

5] Eind v (=] Statlp » & DiEngrave Help
& Hep & MS-DOS Prompt 5 uninstal

2] “Windaws Explorer

31 RAun...

&P ShutDown...

Click the drop-down arrow for the name and click
3 [Roland MODELA MDX-20]. Then click [OK].

Print Setup 2=l

Frititer
Hame: |ﬁ?|..aﬂd..M.E.!D.E.!-.ﬁ.M.Q??:.’f’.’f.....................i...j ’ Properties

Status:  Readp
Type: Foland MODELA MD-+

ey

Cancel

/—\\
™~

From the [File] menu, click [Preferences...].
2 The [Preferences] dialog box appears.

(& Untitled - Di.PICZA

Elle Edit Control Yiew Help
New Chrl+M
Open Crl+0
Save Chrl+5
Save Az

Export 3

Prrint. Crl+F
Print Presiew
Page Setup...

Preferences.

If You're Using Windows NT4.0/2000/XP

If the printer port for the Windows driver and the communica-
tion port for Dr. PICZA are set to the same port, you cannot use
Dr. PICZA.

To perform scanning, you need to temporarily set the Windows
driver printer port to a different port.

After you finish scanning, return the setting for the Windows
driver to its original value.

From the [File] menu, click [Print Setup...].
2 The [Print Setup] dialog box appears.

%‘%Unlilled - Di.Engrave
File Edit “iew Format Sharp

New... Crl+N J
Open... Crl+0 H
Save Cirl+5

Save fs...

Impart....

Select Source...
Agcquire.

Brint. Clrl+P
Print Prexview
Print Setup...
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@ 3D Engrave

1

Click [Start].
Point to [Roland 3D Engrave] and click [3D
Engrave].

=] Programs 3 ‘

% Documents ¥ =] Accessories » ‘

_'¢_‘-£g Settings ¥ =) Roland 30 Engrave b £ 3DEngave

5] Find ¥ = Startllp * &> DiEngrave Help
& Help B Ms-005 Prompt By uninstal

21 Run 2] Windoves Explorer

&P Shut Down...

Click [MDX-20], then click [OK].

Machines selection x|

Specifications

Madeling area # 152.4mm

N0 A MM-3) Y 101.6mm

| PR [CakM-3) 2 S
library versiy 1.00 Feed Rate 0.1 - 15.0 mmi's

2101 -15.0 nm?
ANCEL s

Click the drop-down arrow for the name and click
[Roland MODELA MDX-20].
Then click [OK].

Print Setup Alx

Frinter
. " e > m

" Landscape

Cancel

Hame:  [Roknd MODELAMDICwe

Status:  Ready

11

From the [Cut] menu, click [Machines...].
The [Model Selection] dialog box appears.

Belief Cut  Help
Layout.

LCreate Tool Path

Cut Margin

Cutting Parameters.
Customize Parameters.
Path Direction...
Machines...

From the [File] menu, click [Output Device Setup].

The [Print Setup] dialog box appears.
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How to Use Help

If you have trouble using the program or driver, see the help screens. Help contains information such as descriptions of software opera-
tion, explanations of commands, and tips for using the software more effectively.

1 From the [Help] menu, click [Contents].

st Help

Cantents
About,

Clicking on an image area that contains an
3 explanation displays the explanation.

Commands - [Edit] menu

Click an any itermn to learn mare abaut it

Eile Wiew Object Help

Undo ChilZ
Cut Chrl
Copy Chrl+C
Paste Chil+y
Delete Del

Select Al Clrl+d

When there's a [?] button on screen

Clicking [?] in the upper-right corner of the window makes
the mouse pointer change to a question mark ( Q‘? ). You
can then move the pointer over any item you wish to learn
more about, then click on the item to display an explana-
tion of it.

on COM1: Properties @ﬂ

Clicking on text that is green and underlined (by a
2 solid or dotted line) displays an explanation.

Qontenls| Index | | Frint | |

Contents - Help

B Overview
B Names and Functions of Screen ltems

M Operation Procedures

Step 1: Introduction
Step 2: Setthe area
Step 3: Set the conditions

Tip:
- When the pointer moves over green underlined
text, it changesto a pointing hand ( {ET} ).

- When the pointer moves over alocation where an
explanation isincluded, it changesto a pointing

hand ().

When there's a [Help] button on
screen

Clicking [Help] lets you view help for the window or
software.

ok | Cancel | |
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6 Operation Guide [Cutting Section]

This section provides a step-by-step explanation of the basic procedures for cutting a solid objects with MODELA.

In this section, it is assumed that you have already completed making the three-dimensional data for the solid object. It is assumed that
the three-dimensional data you have prepared is three-dimensional datain DXF format.

- Open the three-dimensional data with MODELA Player and set the cutting parameters.
- Install the cutting tool and mount the workpiece on MODELA.

- Set the reference point for cutting.
- Perform surfacing and start cutting.

This explanation takes the sample datafor the MODELA programs as an example of a solid object to be cut.

Create the Cutting Data

Prepare the data to be cut with MODELA, and set the cutting parameters with MODELA Player.

Open the File

From the [File] menu, click [Open...].
1 The [Open] dialog box appears.

_a Untitled - MODELA Player : MDX-#
Fil= Edit “iew Qption Help
Open... Chrl+0

Set the Cutting Parameters

2 Choose the desired file and click [Open].

T el

i Files of type: |Proiecthata Files [*.rndj/*. duf~ stl)

The cutting parameters are the parameters for cutting the solid object.

For MODELA Player, make these settings:

Cutting surface : The surface of the solid object to be cut

Size : The size of the finished object
Depth : The depth of cutting
Material : The composition of the workpiece to be cut

Cutting process : The stage of cutting

Tool : The diameter of the cutting tool and the shape of the tool’s tip

these conditions are selected.

When you set the parameters, the optimal movement speed, cutting-in amount, and so on when performing cutting under

When you use workpieces and tools for which choices are aready available, then unless an incorrect selection is made, there
is practically no chance of the tool breaking. Choose the loaded workpiece and the installed tool.

When you use workpieces and tools for which choices are not available, the cutting parameters must be entered with great
care. An incorrect setting may result in overload that makes it possible for correct cutting to continue, and in worst cases may

cause the tool to break.




Make the settings for the cutting condi- _o screw - MODELA Player : MDX-++ (MODELA) ~=loix|
tions. Clicking [NEXT] advances the Fil: Edt View Option Help
setting screens in sequence from A to D. ‘ i v A
Make the settings in order from A to D. Pirection
(Clicking A, B, C, or D inthefigure — Emn
displays the corresponding setting screen, ; B
this should not be used except when it's 345 [ -
necessary to make settings independently.) @Emmm c
Styrenefoam
Draft —D
x “ = "Ll"ﬁmm
/ This displays the path of Tool path ==
? the tool during cutting.
Click hereto advanceto | Press [NEXT] to set parameters ‘ ‘ WEXT ‘ START‘

the next settings. ‘

( I (
A B
. . =10 x . . =10lx]
Select the direction {0l Set the dimension
of the object | Selectthe direction Make the setting for ~ Setthe dimension
Select the direction to be ’ o ?b|ect object's size. Drag the spin
used for cutting the object. A dia up or down, or click Height
In thefigure at right, on anumber and enter a
cutting from aboveis x value from the keyboard. m i
selected. ' - Clicking [Resize] makesit Lenath
¥ : 2 - - : g
possible to specify aratio

for the dimensions. m i

I Rotate

BACK |t NEXT | START

- J -

( I (
C D

. -0 . o

Set the maximum =lolx Tool diameter/ =lolx]
cutting depth Set the maximunm Material/Finish D Tl dlE.
Make the setting for the RGN Tool ﬂ
maximum cutting depth. Diepth Set the type and diameter il
Drag the spin dial up or of the tool that isinstalled. |_| U
down, or click on anumber mmm Material
and enter avalue from the Choose the composition of Material

keyboard. Left .
Clicking [Center] setsthe - the loaded workpiece. Styrenefoam °
depth at alocation mmm Finish
proportional to the height. When cutting a solid object Finish
on amodeling machine, an
Centar attractive finish can be Draft
obtained by first perform-
ing rough (draft) cutting,
then performing fine
_J BACK [ NEXT | START cutting. Set to [Draft] for

: : the first pass, and to [Fine]
for the second pass.
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Checking the Cutting Results

If Virtual MODELA isinstalled and set up, then before you perform actual cutting with MODELA

you can check the shape that will be produced after cutting.

From the [File] menu, click [Print Preview].
1 Virtual MODELA starts.

File Edit “iew Option Help
Open... Chrl+00
Save Ctrl+5
Save Az
Clutput
Qutput Preview

Save the file

From the [File] menu, click [SaveAs...].
1 The [Save As] dialog box appears.

o, Untitled - MODELA Player : MDXack
File Edt “iew 0Option Help
Open.. Chrl+0

Save bz

2 The cutting data from MODELA Player is

imported into Virtual MODELA.
An animated display of tool movement appears,
and the shape after cutting is gradually produced.

VUnlilled - Virtual MODELA <X
File Simulate iew Option  Help

b= LILdk]|

*  For more informa-
R tion on how to
operate Virtual
MODELA, seethe
help for Virtual
MODELA.

|

2 Choose where to save thefile, type afilename, and

click [Save]. Thefile extensionis“.mdj”.

Save As 21X
Savein |2 Pragram [ =AE=

Filz name; |screw [ @ ]
Save as lwpe: |MDDELA Flayer Project Files [*.mdj] j rarerar
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Attach the Spindle Unit

ACAUTION

During cutting or scanning, keep
hands away from the cutting tool
and the probe.

Doing so may
result in injury.

NOTICE Attach the spindle unit securely so that it does not come loose during cutting.

Attach the Spindle Unit

Before attaching the spindle unit, make sure the power to the Modelais switched off.

Engage the notch on the spindle unit with the area
1 of the carriage shown in the figure, and press
down gently with your hand.

When mounting at the low When mounting at the high
position position

22



Insert the cap screws at the locations shown in the
2 figure, and tighten them loosely using the included

hexagona wrench (size : 3 mm). After attaching

all two screws in this way, tighten them securely.

s T

3 Make sure the tubeis at the position shown in the

figure.

Insert the cord for the spindle unit into the jack.

Tube

Make sureit is
at the base of
the cord.

Position the connector so the arrow
points to the back of the unit and
insert.

The Mounting Locations for the Spindle Unit

There are two locations (heights) for attaching the spindle unit.
Choose the correct location according to the cutting tool length and the thickness of the workpiece.

Spindle unit

Carriage /\

T. Spindle operating range
Approximately 60.5 mm (2-3/8 in.)
80.6 mm (3-3/16 in.)

/ }
Approximately

20 mm (13/16in.)

Spindle unit

Carriage

A
------- F--memmm ..  ..gmmmme=s==---------___ Spindle operating
bevees : range
60.5 mm
(2-3/8 in.)
Approximately
Approximate|y 116.5 mm (4-9/16 |n.)
Work plate surface o6 mm (2'3/36 in.)

Load the workpiece and install the tool. When using a base to load the workpiece, mount the base as well.

Make the layout the same as for actual cutting.

Move the spindle to its highest point. When viewed from the side, if the tip of the tool islower than the surface of the workpiece,

remount the spindle unit at the higher location.
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Install the Cutting Tool

ACAUTION

Do not touch the tip of the cutting
tool with your fingers.

Doing so may result in injury.

NOTICE Attach the cutting tool securely so that it does not come loose during cutting.

Toinstall a cutting tool, remove the spindle. It's not necessary to remove the whole spindle unit.

While supporting the spindle by hand, remove the Pull out the spindle from below to removeit.
1 screws at the four placesin the figure. 2

Spindle
Insert the cutting tool into the spindle. Use a hexagonal wrench (size: 1.5 mm) to attach
3 The cutting tool must not be inserted beyond the 4 the included set screws to one side only.
shank.

Set screw

* Insert the set screw straight and install.
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5 Fit the spindle into place as shown in the figure. 6 Lift up the spindle until it touches, and while
holding the spindle in that position, use the

included hexagonal (size: 3 mm) wrench to

loosely tighten the screws you removed in step 1.

After dl four screws are in place, While support-
7 ing the spindle by hand, tighten securely.

% About the Length of Tool Extending Beyond the Spindle Tip

Careisrequired regarding the length of tool extending beyond the spindle for the following reasons:

If too short, the toal tip will not reach the desired depth.

If too long, the tool may strike the workpiece when the tool is raised.
The restricted tool length varies according to the mounting location (height) of the spindle unit and the thickness of
the workpiece. For more information, go to "Attaching the Spindle Unit" and see the figure for "The Mounting
Locations for the Spindle Unit."

25



Load the Workpiece

Prepare a workpiece of the necessary size and load it on MODELA.

A block having amargin of afew millimeters larger than the minimum required size is optimal. Cutting timeislong if too large, and the
solid object cannot be made if too small.

Maximum cutting area of the MODELA

W Z-direction | |

Bottom surface of the carriage N :

62.4 mm (2-7/16 in.)

Workpiece thicker than this value cannot be
loaded.

In actual use, the thickness of the loadable
workpiece varies according to the length of the

mounted tool and the thickness of the base.
Work plate surface —— e

Il X- and Y-direction

MDX-20 : 203.2 mm (8 in.)
= MDX-15:152.4 mm (6 in.)

'

— SN

: Maximum cutting area
The area demarcated by
lines passing through the
centers of the four holes as
shown in the figure is the
suggested maximum cutting

MDX-20 : 152.4 mm (6 in.
MDX-15:101.6 mm (4 in.

N

area.
0 0
Remove the screws shown in the figure and detach Apply double-sided tape to the workpiece.
1 the work plate. 2 Make the adhesive surface broad so that the

workpiece does not come loose during cutting.
With ablock like that in the figure, for example,
apply the tape so there are no gaps on any side.

Double-sided
tape

}

Workpiece
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Mount the workpiece with its corner aligned with Install the work plate.
3 the position of the work plate in the figure. 4

When performing (_f—
cutting, use the _

surface with no grid.

0(\

/.

The center of the hole at the lower
left of the work plate is the sug-
gested X- and Y-direction machining
reference point for Modela.

Press in all the way, until flush.

Attach the Front Cover

NOTICE Be sure to attach the front cover. If not installed, cuttings may scatter and enter nearby computers or other
equipment, resulting in breakdown.

Attach the front cover. If the cover is not attached, the VIEW LED lights (every 1 sec.) up and MODELA does not operate.

Fit the cover plate into place from above
so that it goes into the portion shown in
thefigure.

[ — W— - S—

U

i




Powering ON

NOTICE Before switching on the power to the MODELA, turn on the compuiter.

Pressthe STANDBY key. The unit performsiinitial operation and stops, and
1 The STANDBY LED lights up. 2 the VIEW LED and MODELING MODE LED
light up.

* During initial operation, a sound may be heard
for some 20 seconds at the time of origin
detection.

Perform Surfacing

ACAUTION

Wear dust goggles and mask during Do not allow children to operate
o use. ® without adult supervision or operate

Cutting dust within reach of young children.

may scatter, Doing so may result in injury.

causing

bodily injury.

During cutting or scanning, do not Do not operate if a transparent cover
place hands near the cutting tool or is cracked or broken.

the probe. If the transparent

cover at the front
or the side of the
unit is cracked,
contact a service
agent
immediately for
repairs.

Doing so may
result in injury.

NOTICE Do not perform cutting using cutting oil. Doing so may result in breakdown.

Cut the surface of the loaded workpiece to eliminate unevenness and create a level surface.
Thisis called "surfacing.”

Follow the steps below to perform surfacing.
Refer to each item for the details of each step.
1. Set the depth-direction reference point.

Set the depth-direction reference point on the top surface of the workpiece.
MODELA takes the position of the tool just before starting cutting as the depth-direction reference point.
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2. Verify the cutting position and the height when the tool is lowered.

Use MODELA Player to move the MODELA tool, then verify the following two points.

- Object Cutting Position
Make sure that the cutting position specified with MODELA Player matches the position of the workpiece loaded on the
Modela.

- Height When Tool Is Lowered
Move the tool, and verify the height when the tool islowered to the depth-direction reference point.
If the height of the workpieceis not uniform, cutting deeper than the surface of the workpiece may be performed when the
tool islowered to a position other than the position set for the depth-direction reference point.
If this happens, then set the depth-direction reference point again.

3. Reset the depth-direction reference point again.

In "2 verify the specified cutting position and the height when the tool islowered," if the tool cut the surface of the workpiece, then
you need to redo the setting.

Reset the depth-direction reference point at the highest position on the workpiece.

If surfacing is started without redoing the setting first, then the amount of cutting in the first pass increases, which may place excessive
load on the tool and make it impossible to complete surfacing.

OK Not OK

Cutting tool —| N
9 Depth-direction

A referen int

Amount cut in first pass\ eference po

==L _/

) Amount cut in first pass
Cutting tool /

] Amount of
Workpiece surfacing

Workpiece

4. Perform surfacing.

1. Set the Depth-direction Reference point

You cannot set thiswhile the VIEW LED islit or during cutting.

While the VIEW LED is lighted, pressing the key Hold down the TOOL-DOWN key to lower the cut-
1 cancels the paused state. 2
The carriage moves to MODELA's X- and Y-direc-
tion machining reference point.

ting tool to close to the surface of the workpiece.

The cutting tool rotates
as it descends

Workpiece
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When thetool tip comes close to the workpiece sur- When the tip touches the workpiece, release the
3 face, carefully usethe key to lower the cutting tool a 4 TOOL-DOWN key.

little at atime. After setting the reference point, do not press the
TOOL-UPor TOOL-DOWN keys.

Cutting tool

Workpiece

2. Verify the Cutting Position and Height When the Tool Is Lowered

From the [Options] menu, click [Layout...]. The blue rectangle is the range of the object.
1 The [Layout/Surfacing] dialog box appears. 2 When you double-click one of the black circlesdis-
played at the corners of the object, the cutting tool

_o screw - MODELA Player - MDX-++ [MOD descendsto the depth-direction reference point at that

File Edit “iew Option Help location.

T Laout. i Double-click black circles in the sequence shown
Abetrat N by t_h_e numbers in the figure and verify the cutting
= position.

Customer Parameter... To move the object's cutting position, drag the blue
Path Directiar... rectangle.
Machines...

S

Black circles

— Blue rectangle

If the workpiece is cut when you lower the cutting
3 tool at positions 1 through 3in step 2, then skip ahead

to the next section, "3. Reset the Depth-direction

Reference Point."

If it isnot cut, then proceed to step 2 of "4. Perform

Surfacing" and perform surfacing.

without performing surfacing, then click [OK]. ak.

To make the setting for the cutting position only
| cemcer | I
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3. Reset the Depth-direction Reference Point

Press the TOOL-UP key to move the cutting tool In MODELA Player's [Layout/Surfacing Settings]

away from the workpiece. 2 dialog box, In the dialog box, drag the white circle
to move it next to the black circle where you per-
formed cuttingin"2. Verify the Cutting Position and
Height When the Tool IsLowered.” Inthisexample,
it'sassumed that the black circle shownin thefigure
was cut.

7

Place cut deeper than
the surface

/ffg/g

&

Move the white circle

0K, CANCEL | Ij

. . Press the TOOL-DOWN key.
When you click j[he _l._;U button, the cutting tool 4 Release the key when the tip of the cutting tool
movesto the white circle. touches the surface of the workpiece.
The depth-direction reference point has now been
reset.

Cutting tool

—Workpiece

Lower the cutting tool at the four remaining corners
5 with the new reference point, and make sure that the
workpiece is not cut. (See "2. Verify the Cutting
Position and Height When the Tool Is Lowered" in
the previous section.) If the workpiece is cut, then
repeat steps 2 and 3 and set a new reference point.
* When you view theloaded workpiece edge-on from
the side, if there is any location higher than the
four corners, then move the cutting tool to that |o-
cation and redo the setting for the depth-direction
reference point.

Redo the setting at the high location
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4. Perform Surfacing

From MODELA Player's [Option] menu, click
1 [Layout]. The [Layout/Surfacing Settings] dialog

box appears.

_o screw - MODELA Player : MDX-++ [MOD

File  Edit

Lavout. ..

Abstract

Custorner Parameter. ..
Path Direction...

achines. ..

“Wiew Option Help

To changetherange and location for surfacing, clear
3 the selection for [Automatic].
To changetherange, drag the solid squares surround-
ing the shaded area, or type in numerical values for

[Width] and [Length].

To change the location, drag the shaded portion or
type in numerical values for [Lowerleft X],

[Lowerleft Y].

7

.

Surfacing
Depth '3_
[~ Automatic
width  [709
Length 'W
LowerLeftXW
LnJLJ\.'erLeft‘r"W
mm

5 When surfacing ends, click [OK].

277777
)4

Enter the surfacing depth.
2 Here you set the cutting depth from the depth-
direction reference point.

mm

Surfacing
Depth |3

3 Adbarashie

Click [Start] to start surfacing.
When surfacing ends, the depth-direction refer-
ence point is set at the surface after surfacing.

LowerLefty |-13.1
T
Stark
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Perform Cutting

A three-dimensional object is cut in two stages: draft cutting and finishing.

First pass Draft cutting High-speed cutting that leaves a margin for finishing
Second pass Finishing High-precision cutting of the margin on the workpiece surface left by draft cutting

When finishing ends, cutting is complete.

Depending on the composition of the workpiece, however, finishing may not actual produce an attractive finish.

In such cases, use afile or the like to work it by hand.

1 Click [START] to start cutting.

Tool path ==
[ ‘ NEX ‘START‘

Pausing or stopping operation

Pressthe VIEW key to quit the cutting operation.

To continue with cutting
Pressthe VIEW key again.

To end cutting
Stop sending data from MODELA Player.

1 Open the [Printers] folder.

Windows 95/98/M e/NT4.0/2000:
Click [Start]-[ Settings]-[ Printers].

Windows XP:

Click [Start]-[Control Panel]. Click [Printers and
Other Hardware], then click [Printers and Faxes).

3 At the [Printer] menu, choose [Purge Print Jobs] or

[Cancel] to stop sending data.

If you're using Windows 2000/X P, choose [Cancel

All Documents).

Double-click the printer icon for the machineyou're
using. If you're using the MDX-20, double-click the
[MODELA MDX-20] icon. If youreusing the MDX-
15, double-click the[MODELA MDX-15] icon.

To delete cutting data remaining in MODELA,
press the Modela TOOL -UP and TOOL-DOWN
keys at the same time.

The VIEW LED flashes. When the LED stops
flashing, deletion is finished.
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When Cutting is Finished
A\CAUTION

When not in use for several hours, When you're finished,
unplug the power-cord plug from the wash your hands to
electrical outlet. rinse away all _

Failure to do so may cuttings.
result in danger of
shock, electrocution,
or fire due to
deterioration of the
electrical insulation.

Use a commercially available brush
0 to remove metal cuttings.
Attempting to use
avacuum
cleaner to take
up metal cuttings
may cause fire in
the vacuum
cleaner.

NOTICE Be sure to aso remove any buildup of cuttings under the machine.
Continuing to use the machine without removing cuttings may result in built-up cuttings getting inside the
mechanism, leading to breakdown.

Do not use an air blower to remove cuttings by blowing them away. The cuttings may get inside the mecha-
nism, resulting in breakdown.

* Be sure to remove cuttings only after MODELA has finished cutting.

1 Pressthe STANDBY key to switch off the power. 2 Remove the workpiece you have finished cutting.
If the workpiece does not peel off easily, use
commercially available ethyl alcohol and a
wooden spatula or the like to removeit.

3 Remove fallen cuttings from around the workpiece

and the table.

Metal cuttings Other cuttings

Remove using acommercially available brush. Remove using acommercially available brush or with a
vacuum cleaner.
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Remove any buildup of cuttingsfrom under thetable.

Metal cuttings

Detach the work plate.

While holding down the STANDBY key, switch on
the power to MODELA.

Pressthe VIEW key and movethetable. Useacom-
mercially available brush to remove any metal cut-
tings that are exposed.

After removing the cuttings, hold down the
STANDBY key and switch off the power.

Other cuttings
Detach the work plate and use a vacuum cleaner to
take up any cuttings.

Unplug the power-cord plug from the electrical
outlet.

5

Lift up MODELA and aso remove any cuttings
that may have fallen underneath.
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7/ Operation Guide [Scanning Section]

Attach the Sensor Unit

NOTICE Attach the sensor unit securely so that it does not come loose during cutting.

Perform installation and removal of the sensor unit while the cover is attached.
If the cover is not present, the probe may be damaged if the sensor unit should fall or be dropped.

Before attaching the spindle unit, make sure the power to the Modelais switched off.

If the spindle unit isinstalled on the carriage, then Engage the notch on the sensor unit with the area
1 remove it. Do this by following the stepsin 2 of the carriage shown in the figure, and press
“Attach the Spindle Unit” in reverse order. down gently with your hand.

Insert the cap screws at the locations shown in the While gently pressing down on the cover with one
3 figure, and tighten them loosely using the included 4 hand, loosen the screw shown in the figure.

hexagonal wrench (size : 3 mm). After attaching

all four screwsin thisway, tighten them securely.

Screw

Cover
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5 Pull the cover back to removeit.

Detaching the Sensor Unit

3

Fit the cover onto the sensor unit as shown in the
figure.

Sensor unit
Cover

ol

Sensor unit

2/

the cover into

Fit the notch in

the area shown
by slanted lines.

Remove the sensor unit by following steps 2, 3,
and 6 of "Attach the Sensor Unit" in reverse order.

2

Screw

Cover

Make sure the tubeis at the position shown in the
figure.
Insert the plug for the sensor unit into the jack.

Tube

Make sureit
is at the base
of the cord.

Position the connector so the arrow
points to the back of the unit and insert.

While gently pressing down on the cover with one
hand, tighten the screw shown in the figure.
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Load the Object to Be Scanned on the MODELA

The sensors for the MODELA are highly sensitive, and can even scan three-dimensional objects made out of clay.

You can usually perform scanning if the three-dimensional object is of acomposition and configuration that can retain its shape.
However, the pressures that the sensors detect are from several gramsto several tens of grams, so you cannot scan objects whose shape
changes when touched by the sensors. (Pressure may fluctuate, depending on the composition of the object being scanned.)

For instance, it may not be possible to scan something like a fuzzy stuffed animal or rubber.

Depending on the shape you're scanning, a maximum error equal to the radius of the probe (0.5 mm) may occur.

. [ Maximum
Maximum scanning area of the MDX-20  208.2 mm (@ n) e
MODELA | MDX-15:152.4 mm (6 n.) i

The maximum scanning areais shown in the figure.

—

MDX-20 : 152.4 mm (6 in.)
MDX-15 : 101.6 mm (4 in.)

60.5 mm (2-3/8 in.)

Work plate 4\ 1 mm (0.0394 in.)
* This space cannot be scanned.
Remove the screws shown in the figure and detach Orient so the surface with the grid faces up.
1 the work plate. 2 Mount the object to be scanned.

Secure the object to be scanned in place on the
work plate for scanning.

Mount the object to scan securely in place so that
it does not move during scanning.

The grid on the table serves as a guide for
mounting the object to scan.

It does not indicate the scanning areafor Dr.
PICZA.

The scaleisin 10 mm (3/8in.) units.

When the shape has a flat bottom and is easy
to secure in place
Securein place with
double-sided tape.

3 e . L__

When the bottom is uneven and difficult to
secure in place

When scanning as far as the bottom surface
of the object to be scanned

Make a base using clay, and press the
object into the clay base from above to
secureit in place.

Press in all the way, until flush.

38



Attach the Front Cover

Attach the front cover.

Powering ON

the figure.

Fit the cover plate into place from above
so that it goes into the portion shown in

R W—— —

U

v
]

NOTICE

Before switching on the power to the MODELA, turn on the computer.

1

Press the STANDBY key.
The STANDBY LED lights up.

2

The unit performsinitial operation and stops, and
the SCANNING MODE LED lights up.

Setting Scanning Conditions and Starting Scanning

About scanning conditions and the scanning area

Y SCAN PITCH
(Spacing of adjacent scan points along the Y axis)
e O L E LR EEEEEE REEEE ° L
E Scanning area E
N :
C < ;
- - :
: I € ¢I :
o i e
\ [ R R L L L LT T T © y,
X SCAN PITCH —— : Scan path

(Spacing of adjacent sc
points along the X axis)

an (bidirectional scanning)

. : Scan points

Scanning Area

Workpiece plate
|
150 (- - L
| a
I |
— ] I
100 — i |
— I I
— I I
I |
— I I
— I |
50— |
— | p . |
I : 1 1 :
-l i i i
Y [ — e —— I
Lt ettty
0 150 100 ! 150 200
Scan object ! ' Z Upper
: S——€=|Limit
Clay

I
Workpiece plate

ZBOTTOM
(Height of the scanning

area's

bottom plane)

* If you have made a clay base, the height of the
clay is taken to be the Z-axis reference surface.
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Setting scanning conditions and starting scanning

ACAUTION

During cutting or scanning, keep
hands away from the cutting tool
and the probe.

Doing so may
result in injury.

Start Dr. PICZA and make the settings for scanning resolution, the lower limit for the height of the surface to scan, and the scanning
quality.

= Make the settings for X scan pitch and Y scan
1 Click [¢% | on the Dr. PICZA. 2 pitch.
Controller |
The Controller window opens.
b X SCAN PITCH

When Dr. PICZA is started, the Controller window

is aready open. m =
fmm| -

Y SCAN PITCH
_USUEE
Make the setting for Z bottom. Make the selection for scanning quality.
3 If you have made a clay base, the height of the 4
clay istaken to be the Z-axis reference surface.
¥ (UM
=R | - |
Scanning Area
ZBOTTOM I— —l

i Fine

Craft |

m -
i) -

|_ =TT ]
| [Qeranninn Araa I
Select [Smart Scan]. When thisis selected, Click [SCAN].
5 MODELA identifies and limits the scanning area Scanning starts.
before performing scanning (X and Y directions (During scanning, the sensor may emit atransmis-
only). sion sound, but thisis normal.)
To specify the scanning area manually, deselect
[Smart Scan], then click [Set Scanning Area). For Fine Oraft
more information on how to specify this, see 4
“Setting the Scanning Area” in the next section. ‘ Srhart Scan
: SCAN
Fine | Drait For detailed descrip-
‘ Srart Scan tion of the available
Controller buttons,
SCAN please refer to the help
screens for Dr.
PICZA.
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If You're Using Windows NT4.0/2000/XP

If the printer port for the Windows driver and the communication port for Dr. PICZA are set to the same port, you cannot use Dr. PICZA.
To perform scanning, you need to temporarily set the Windows driver printer port to a different port.
After you finish scanning, return the setting for the Windows driver to its original value.

Use the following examples as a guide to determine the amount of computer memory required to perform scanning.

* The figures shown below are the amounts used by Dr. PICZA alone. They do not take into account the amounts used by the operating
system or other programs.

Example: Required memory when scanning a 100 mm x 100 mm (3-15/16 in. x 3-15/16 in.) area

- Scanning at a pitch of 0.05 mm x 0.05 mm (0.002 in. x 0.002in.) : Approx. 2 GB
- Scanning at apitch of 0.1 mm x 0.1 mm (0.004 in. x 0.004in.):  Approx. 500 MB
- Scanning at apitch of 0.5 mm x 0.5mm (0.020in. x 0.020in.) :  Approx. 20 MB

Setting the scanning area

If you wish to limit the scanning area, such as in cases where you wish to scan only a portion of an object, make the settings as described
below.

. - . Make the settings for the scanning area.
1 CI_ICk | Scanning -Area | |r.1 the Controller 2 Make the settings to match the location where the
window. The [Scanning Areg] dialog box appears. scan object is secured in place.

Either of the following two methods can be used to
make the settings.
Click [Begin AreaTest].
3 The sensor moves to a position above an outer - Use the mouse to move the blue frame on screen.
point on the scanning area that has been set.
Make sure the scan object that has been secured in
place lieswithin the area.

x: [raa ﬂ [10g3 le .

580 i’
f—\@I_‘“ =
lginAreaTe.t_l Cancel Area Test |_
NS

E

- Enter the numerical values for the upper-right
and lower-left points.

The size of the on-screen scanning area (shown in
blue) changes to match the values that are entered.
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Click [Z Upper Limit].

The cursor @ isdisplayed on the Z upper-limit

setting on screen.

Specify the highest position of the scan object.

Clicking [Apply] or double-clicking on the target

lowers the sensors to the target's center position.

If the target is displaced, redo the settings.
Set the Z upper limit to the highest
position on the object to be scanned.
During scanning, if the sensor detects a
position higher than the Z upper-limit
setting, the setting is cleared and scanning
continues with the greatest scan height of
Dr. PICZA as the Z upper limit.

¥ Scan Pitch
| 050 M
Y Scan Pitch
.
Z Bottom
)8 8 4 3 .
|580
{rm}
164 :I
Cancel Area Test I Reset

5 After determining the scanning area, click [OK].

Xl
E.j
L N/ |
X Scan Pitch

=

Check the scanning conditions in the Controller
window one more time, then click | |
Scanning starts. (During scanning, the sensor may
emit atransmission sound, but thisis normal.)

- For the scanning area and Z upper limit, please refer to "7 Operation Guide [scanning section] About scanning conditions and the
scanning ared".
- For detailed description of the available Controller buttons, please refer to the help screens for Dr. PICZA.

Cancels scanning/Pauses scanning

Processing ll
MNow Recieving data
Estimated Processing Time ©  [iffd]
Cancels scanning. Any |ll Scanning pauses and the
data scanned before being table moves toward the
canceled remainsin I C_a_nc_el_ _ | ‘ WEW = I front of the unit.
memory. J Click [VIEW] again to
¥-Scan Pitch F-Offset resume scanni ng.
0.580mm 10mm
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Saving Scanned Data

) Choose the desired location for saving the file,
1 Click and choose [Save]. 2 enter afile name, and click [SAVE].
The[SaveAs] dialog box appears. The extension ".pix" is appended to the file name.

If you want to export the dataas afilein DXF or VRML format, please refer to the help screens for Dr. PICZA.

Edit the Scanned Data

The shape of an object can be edited. It ispossible to vary the height, adjust the slant, or perform concave/convex inversion (height
inversion) for adesired surface.

You can use the toolbar button or select [Edit] on the menu bar.

Please refer to the help screens for Dr. PICZA for detailed explanations of the various functions that are available.

Be sure to save the scanned data before starting to edit.

When you're done editing, be sure to save your file.

When Scanning Is Finished
AN\CAUTION

When not in use for several hours,

% unplug the power-cord plug from the
electrical outlet.
Failure to do so may
result in danger of
shock, electrocution,
or fire due to
deterioration of the
electrical insulation.

1 Press the STANDBY key to switch off the power. 2 Remove the scan object from the table.

When not in use

- Remove any clay from table, and store the clay so that it will not dry out.
- Unplug the power-cord plug from the electrical outlet.
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8 Overview of the Usage Guides

Theincluded Roland Software Package CD-ROM contains the following PDF files.

- Cutting Tips
This describes tips and tricks for double-sided cutting and methods for securing the workpiece in place.

- Scanning Tips
This describes how to shorten scanning times and perform rescanning.

Location of the Usage Guides

The usage guides are found at the following locations.
View the following files directly from the CD-ROM, or copy the following files to your hard disk and read them from there.

Cutting Tips  : [Document] - [Cuttips] - [Cuttip-e.pdf]
Scanning Tips : [Document] - [Scantips] - [Scatip-e.pdf]

Installing the Acrobat Reader

Acrobat Reader isrequired to view PDF files.
If Acrobat Reader is not set up on your computer, you need to set it up.
Theincluded CD-ROM also contains Acrobat Reader.

[Acrobat] - [English] - [ar405eng.exe€]
(This runs under Windows 95 or later.)
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9 Software Guide

This describes the general procedures for software you can use with MODELA.
For detailed descriptions, take alook at the help screens for the respective software.

* The explanationsin this section describe operation of the MDX-20. If you're using the MDX-15, then where "MDX-20" appearsin thetext, read "MDX-
15" instead.

Driver for Windows 95/98/Me

This section explains how to make the settings for the engraving parameters.

When sending data from Dr. Engrave or acommercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch. When sending data from MODELA Player or 3D Engrave to MODELA, the datais sent to the
driver’s output port. At thistime, all driver settings other than the port are ignored, and do not affect cutting.

Display the Driver Setting Screen

To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.

Method 1
When you use this method to make the settings, any changes you make in Properties a so affect other Windows-based programs.
Click [Start]. Point to [Settings] and click Right-click on the [Roland MODELA MDX-20]
1 [Printer]. 2 icon, then click [Properties].
The [Printers] folder appears.
=] Programs 4 :MDDEE; Dpen
% Documents 3 e Pause Printing
j;fg Settings ¥ =] Control Panel F’;rge Print Jobs
2] Find b [ Printers Set As Default
@ Help j Taskbar... Create Shartcut
271 Bun. T Delete

Rename

Properties

Method 2
From the [File] menu, click [Print Setup...]. Set the printer to [Roland MODELA MDX-20],
1 The [Print Setup] dialog box appears. 2 then click [Properties).
# Untitled - Dr.Engrave Print Setup
File Edit “iew Format Shap Printer
S?.:n E::::g l Mame:  [Roland MODELA MOk Properties
Save Cirl+5

Status: Ready
Save fs...

Impat... " Landscape

Select Source...

Acauire, Cancel
Brint. Clrl+P

Print Prexview

Print Setup...
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Enter the Cutting Area

Enter the size of the plateinstalled on MODELA.

1 Click the [Siz€] tab. 2 Enter values for [Width] and [Length].

oland N\DELA MDX-++ on COM1: Properties 21x| Roland MODELA MDX- ++ on COM1: Properties 2] x|

| 1 Dptions} Size ITqu ] Upt\uns]
Enarzl g Area Engraving Are-,
widh:  [2002 4 Width:
Length [t5z4 4 Lenath

Set the Engraving Parameters

Make the settings for the composition of the workpiece to engrave and the engraving depth.

Choosing the composition sets engraving parameters suited to this engraving. However, [Z Down Position] and [Fill Pitch] are deter-
mined with no relation to composition, and so they are set separately. For [Z Down Position], enter the engraving depth. For [Fill Pitch],
enter the tool diameter.

The values for settings other than [Z Down Position] and [Fill Pitch] are also suggested guidelines. If the results of actual engraving are
not as expected, modify the values accordingly.

Lines are distinguished by color, and parameters when engraving aline of the corresponding color are set.

Click the [Tool] tab. Click the drop-down arrow for [Material], then
1 — 2 click the composition of the engraving material
Rol7gd MODELANADX- ** on COM1: Properties 7| x .
workpiece).
Tool ]D |ons} ( p )
y /- [ Roland MODELA MDX-#+ on COM1: Properties x|

1M 2| 3| 4|ms|m | 7] sia  Todl | options|

W 2N 3| 4w 5N W 7 s]‘

Material : |5tprenefoam

TIm 2] 3] 4 |m 5| g

W T W 3 e W s W s W 7 =

Click the tab for the color to set. Click the drop-down arrow for [Tool], then click
3 The numeral appearing next to the color is the tool 4 the tool number.
number that is now set. If you don’t wish to engrave lines of that color,
Roland MODELA MDX-+#* on COM1: Properties x| click [None]'
Size  Tool | options | Roland MODELA MDX-++ on COM1: Properties 21 x|
Material: [Stwrenefoam b Size  Tool IDpt\uns]
1T]M z|T 3| 4|Ms|me|” 7| - Material: [Styrenefoam -l
Wz 3| W s W | 7] s]‘ i - s Esm | 7|
Tool : 1 = I LA AR R
Toal
For [Z Down Position], enter the cutting-in depth. For [Fill Pitch], enter the diameter of the tool tip.
5 FG R 6 To achieve an attractive finish, enter avalue
Fil Fich: — | narrower than the actual diameter.
Wj [rom] y

¥ Fil Z Up Pasition :
Fill Fikch - |
- 0.50 =1 [rm]
1.50 o] 2Z Dovin Position :
Default =
Lefaul Wj [rm]

Z Engraving Pitch

=
Defait 1.00 = [m]

Q_
|§ For [Fill Pitch] and items other than [Fill Pitch], suitable values are set for engraving the composition you chose in
step 2. However, these values are only suggestions. If the results of actual engraving are not as expected, adjust the
values accordingly.
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Driver for Windows NT4.0/2000/XP

This section explains how to make the settings for the engraving parameters.

When sending data from Dr. Engrave or acommercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch. When sending data from MODELA Player or 3D Engrave to MODELA, the datais sent to the
driver’s output port. At thistime, all driver settings other than the port are ignored, and do not affect cutting.

To make the settings for the Windows NT4.0/2000/X P driver, log on to Windows as "Administrators' or "Power Users' account.

Display the Driver Setting Screen

To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.

Method 1

When you use this method to make the settings, any changes you make in Properties al so affect other Windows-based programs.

1 Open the [Printers] folder. 2

Windows NT4.0/2000:
Click [Start]-[ Settings]-[ Printers].

Windows XP:
Click [Start]-[Control Panel]. Click [Printers and
Other Hardware], then click [Printers and Faxes].

% Windows Lpdate
] Frogams

Y Documents
}%} Settings

(‘Q Search

& 1

Eﬂ Run,

@ Shut Down

i start

»
»
» |20 Control Panel

, 2 Hetwark and Diskup Connections
Prinkers

N Taskbar & tart Menu...

Method 2
From the [File] menu, click [Print Setup...].
1 The [Print Setup] dialog box appears. 2

%‘%Unlilled - Di.Engrave
File Edit “iew Format Sharp

New... Crl+N J
Open... Crl+0
Save Cirl+5

Save fs...

Import.

Select Source...

Aguire.

Errint. Chrl+F

Print Preview

Print Setup.

Windows NT4.0:
Right-click the [Roland MODELA MDX-20] icon,
then click [Document Defaults].

Windows 2000/XP:

Right-click the [Roland MODELA MDX-20] icon,
and click [Printing Preferences]. Then, click [Ad-
vanced].

Open
"Foland !
MODELA!  Set as Default Printer
(MO 5] printing Preferences. ..

Pause Printing
Cancel All Documents

Set the printer to [Roland MODELA MDX-20],
and click [Properties).

If you're using Windows 2000/XP, then click
[Advanced)].

Print Setup 2l
Frinter
Mame: [Foland MODELA MD=- j Broperties
Status: Ready
oland (3 —{_
Landscape [~
Cancel
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Enter the Cutting Area

Enter the size of the plateinstalled on MODELA.

Windows NT4.0:
1 Under [Document Optiong], click [Work Size Settings].

Windows 2000/XP:
Under [Document Optiong], click [Work Size Settings].
Click [Properties].

The [Print Setup] dialog box appears.

Click [Add New Work Size], then for [Work Size], enter
2 values for [Width] and [Length].

3 Enter the [Work Size Name], then click [OK].

Roland MODELA MD¥X- += Advanced Options

Roland MODELS MD-%x Advanced Document Settings
E% Paper/Oukput

Work Size Setting 2=l

Wwork Sizes List work Size Mame oK |

203.24152.4
NewaormU NewFormi T

Unit
& mm " Inch

ik Size

M
Add New Wk Size Wwidth [203.2 1 232
i 2 Length [152.4 j 1524

?

Work Size Setting d|
Wwork Sizes List work Size Mame @
£ . |MewForml

Lirit
& mm " Inch

x

—
[t
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Set the Engraving Parameters

Make the settings for the composition of the workpiece to engrave and the engraving depth.

Choosing the composition sets engraving parameters suited to this engraving. However, [Tool Down Position] and [Fill] - [Tool Width]
are determined with no relation to composition, and so they are set separately. For [Tool Down Position], enter the engraving depth. For
[Fill] - [Tool Width], enter the tool diameter.

The values for settings other than [Tool Down Position] and [Fill] - [Tool Width] are also suggested guidelines. If the results of actual

engraving are not as expected, modify the values accordingly.

Lines are distinguished by color, and parameters when engraving aline of the corresponding color are set.

Double-click any tool from 1 to 4 to display the
lower level.

Click [Materidl], then click the composition of the
engraving material (workpiece).

2

Double-click [Color] to display the lower level.
Click the color to set, then click the tool number.
If you don’'t wish to engrave lines of that color,
click [None].

Roland MODELA MDX-++ Advanced Options 2
i a5t Shyrenefoam ;I

o kee (e '
I Plasker
H- Mo.4
[+ Mo.5 I
[ od{Hard)

Double-click on the tool number to display the For [Fill], click [Tool Width], then enter the

3 lower level. 4 diameter of the toal tip.
Click [Tool Down Position] and enter the cutting-
in depth.

- Tool Wwidth: 0.30 [
Z-Speed: 1.0 [mmjsec

W

- § mol
- Polyn s —
Graal width: :[0.30
o

e B P —

- W-Speed: 12.0 [mm)sec
- & Down Postion: -0.01 mm

- £ Up Position: 0,50 mm

- Z Engraving Picch: 1.00 mm LI

o]

T AL ITET=

Z Engraving Pitch: 1.00 rmm LI

o]

Cancel |

|E For items other than [Tool Down Position] and [Fill] - [Tool Width], suitable values are set for engraving the composi-
tion you chosein step 1. However, these values are only suggestions. If the results of actual engraving are not as
expected, adjust the values accordingly.
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MODELA 3D DESIGN

This lets you choose a basic shape such as a cylinder or sphere, and modify it to create a three-dimensional object.
You can intuitively create solid objects with smooth curves.

Choose the basic shape

_ Click the basic shape that is closest to the finished
1 Click D . 2 form. Enter the size, then click [OK].

The [Primitives] dialog box appears.

Primitives

Parameter(1/10mm)

Radius: 100

Height: 200

Connection 4 3:

Decide on the number of reference lines

The reference lines are control rods for arranging the shape of the object.
To determine the number of reference lines, click the controls shown below.

LAl : 4 lines 120 7lines 13

: 10 lines

Manipulate Reference Lines to Make a Shape

To change the height of areference line, position the To change the size of the outer perimeter for areference
pointer over the reference line and drag it up or down. line, position the pointer over the reference line and drag it

to the left or right.

S~

~ .
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To change the shape of the outer perimeter, right-click on
areferenceline.

The [Select section] dialog box appears. "d’* and drag the reference line.
Make the settings to obtain the desired shape.

To change the centerpoint of the outer perimeter, click

Select zection

—section
Cancel
Option...
Centar
— —Adftribute i
Ellipse
) Radius: 100
Trochoid
Height: IEE 3
EDIygDnJ 2

Check the shape

_ Drag the scroll box for the X, Y, or Z scroll bar.
1 Click the @ . 2 The object rotates, letting you view it from various
The [Rendering] dialog box appears. perspectives. To color the object, click [Start].

= Untitled - MODELA 3D Design =] B I

Rendering

File Edit “iew Objects Hesolution Help

D18 Bl =315 ] ol ()i 2Ll 2 |

Unit: 1/10mm

O N—-—
Ohject2
Ohject 3

Background l:‘

Center |
3 I
4 Erint |

Frinter | Lansout

I
-Heady | o

Mo X
= = =
Iy
= = = ).

Save the data

click the | &gl |-

The [Save As] dialog box appears.
Enter the name of thefile and click [Save].

Save Az

Save jn; I 3 Pragram

File name: IUntitIed Ej

Save as tupe: |3ddesign filerg (", thi) j Cancel |

51



Description of Controls

3

=
(=]

This opens new file.
This opens an existing file.
This saves the file, overwriting the previous data.

This moves areference lines up or down.
When is selected, the location of the
centerpoint moves up or down.

This moves areference lines right and | eft.

When is selected, the location of the

centerpoint moves right and left.

When thisis selected, dragging areference line
changes the size of the outer perimeter.

When thisis selected, dragging areference line
moves the centerpoint of the outer perimeter.

MODELA 3D TEXT

This adds thickness to text to create three-dimensional characters.

This savesthe dataas a DXF file.

This starts MODELA Player.

This undoes the very last operation.

E{ This zooms the screen in or out.

This displays the coordinates of the reference
lines.

This changes the point of view.

This adds color and shadowing to the object's
surfaces.

. . This determines the number of
LBy reference lines.

You can use the TrueType fonts registered in Windows as the font style for text.

Enter the Text

Click the [Edit] text box, then typein the text.
Make sure what you've typed in is correct, then click [Go!].

apUntitled - 3dT ext
File Edit Font Depth

This displays help for 3D DESIGN.

=101

m]
Ix

“iew Help

Fant ;| &ial

j Scale:|50 j Edit : Jl4BC ‘ Gol

B|/

%D A[A i

I IE 2= ) e

71

...,
o

1p s ]

(108, 40 ] B he[-5050)

Ready
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Determine the Font and Size of the Text

Click the [Font] drop-down arrow, then click on a Click the [Scal€] drop-down arrow, then click on a
1 font name. 2 size.
kil Edt Font Depth e
Scale ;|60 @
Forit :|.f1'-.rial @ —r 4
Arial 20
Courier Mew an
b arle:tt a0
Syrnbal alll
Times Mew Roman 1]
YWingdings -
= . . . .
|§ - You cannot specify afont size that is not listed.
- If you want to know the size of the entire text string that you typed in, click [Show Information].

Save the data Save As

Click the .

The [Save Ag] dialog box appears.
Enter the name of the file and click [Save].

Save jn; — Program

File name: |Untilled E]

Save as hupe: |3dTe>:t Files [*.3dt] j Cancel

Description of Controls

This opens new file. [ This lets you choose the color of the object from
D i among ten available colors.
—y This opens an existing file. I I This assigns the desired color to the object.

l!li This saves thefile, overwriting the previous data. This displays dimensions around the object.

This changes how the object is displayed. This saves the dataasa DXFfile.

left or right.

This slants the text in the height direction. This puts aframe around the text.

| |l

This changes the height of the text. This rotates each individual character 90 degrees

counterclockwise.

np | |dow

This determines the roughness of curved This makes the text italic.

[garse| |Fime portions of the text.

This makes the text bold.

A
;_E; This starts MODELA Player. P A This slants each individual character to the

!I This inverts the background color.

53




MODELA Player

For information on how to use MODELA Player, see 6 Operation Guide [Cutting Section].”

Virtual MODELA

You can use atool path created with MODELA Player or 3D Engrave to verify the cutting process and results on-screen before you
perform actua cutting.

You can start this program directly with commands from MODELA Player or 3D Engrave. For more information, see "6 Operation Guide
[Cutting Section] - Sending Cutting Data" or "9 Software Guide - 3D Engrave.”

With Virtual MODELA, you can display the cutting process and resultsin awide variety of ways.

Animating the Screen During Simulation

—
Click the . When this button is off, only the shape after simulation is displayed.

Switching the Screen Between Flat and Three-dimensional Views
During Simulation

L
e Clicking switches from aflat view to athree-dimensional view.
When this button is selected, the view is three-dimensional during and after simulation.

=]
e Clicking switches from athree-dimensional view to aflat view.
When this button is selected, the display shows a view of the workpiece as seen from above during and after simulation.

Changing the Perspective at the Simulation Screen (Only During 3D View)

1
You can use the following buttons only when has been clicked to display a3D view.
e Clicking rotates the object counter-clockwise around the Z axis, in steps of 90 degrees.

e Clicking rotates the object clockwise around the Z axis, in steps of 90 degrees.

Checking the Shape After Simulation

You can use the following buttons only when has been clicked.

* Rotating

You can use the following buttons only when E has been clicked.

54



e Zooming in or out
Click , then drag on the screen.

Zoom in
Drag toward the top of the screen.

Zoom out
Drag toward the bottom of the screen.

* Moving the Location
Click , then drag on the screen.

Description of Controls

[=]

b

This creates a new, uncut workpiece.

This opens an existing cutting-configuration file.

This saves the shape of the present workpiecein a
file.

This performs the cutting simulation over again,
using the presently imported tool path. Use this
when you want to check the movement of the tool

again.

This quits the simulation.

This starts cutting.
If cutting was previously interrupted, it resumes
cutting.

This displays a prediction of how much time cutting
will take. Thetime is ageneral estimate.

In addition to the time, you can also verify the tool
movement distance and movement range.

This displays the simulation screen as aflat (two-
dimensional) view.

This displays the simulation screen as a solid (three-
dimensional) view.

_.? These change the perspective when display-
ing asimulation three-dimensionally.

Thisisfor checking the shape after cutting simula-
tion.

This displays the movement of the tool with
animation.

LOR

Lh"u

This switches between adding and not adding color
to the surface of the workpiece.
To specify acolor, click [Optiong] - [Surface Color].

Thisrestricts the 3D view range.

It also determines the printing area when performing
2D simulation.

Restricting the range makes 3D view faster than
when displaying the entire workpiece.

This pastes and image on the surface of the
workpiece.

By pasting an image of wood or metal, you can
make the workpiece look more realistic.

T o select theimage to paste, click [Optiong] -
[Texture Setup].

This rotates the object, changing the perspective.
Thisisavailable only during 3D view.

This zooms the view of an object in or out.
Thisisavailable only during 3D view.

This changes an object's displayed location on the
screen.
Thisisavailable only during 3D view.

This enlarges or reduces what is displayed to fill the
drawing size.

This selects how the object is

displayed when on the 3D
screen when not performing any

operation.

This selects the image to paste on the surface of the
workpiece.

This changes the direction and brightness of incident
light, thereby changing the shading.
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Dr.PICZA

For information on how to use Dr. PICZA, see“7 Operation Guide [Scanning Section].”
This section describes the controls for Dr. PICZA.

CIOO
I
Sl

+

=t

2 |« €

This unhides and hides the controller window. At
the controller window, you can make the settings
for the various scanning parameters.

These choose how an object moves when
dragged.

This displays the top surface of an object.

These zoom the view of an object in or
out.

This displays the object, filling the view area.

These choose how an object is

vﬁ drawn.

B

Q9 ¥
o

These display the coordinates of the point chosen
with the mouse pointer.

Clicking a start point and an end point shows you
the distance between the two points.

This undoes the very last operation.

/ |— These color a surface of the object.

I

These specify the edit areafor
Cl C’i three-dimensional data.

This specifies the range to rescan.

! — These edit three-dimen-
[><] m f sional data.

—_—

These adjust the slant of an object.

& B |

B

This deletes data in the selected range.

This saves datain various file formats.

This starts MODELA Player.
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Dr. Engrave

Thisis used to design plates and send the engraving datato MODELA.

You can make large numbers of plates with the same design (such as nameplates and rating plates) with high efficiency.

Set the Engraving Area

The following explanation is for Windows 95/98/Me. If you're using Windows NT4.0/2000/X P, then refer to the explanation in "9.

Software Guide - Driver for Windows NT 4.0/2000/XP - Enter the Cutting Area."

1

3

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

&Untilled - Dr.Engrave
Ele Edit “iew Fomat Shap

Mew... Chrl+M l
Open Crl+0 H
Save Chrl+5

Save Az

Import.

Import Text...

Select Source...

Aguire.

Errint. Chrl+F

Print Preview

Print Setup.

Enter the size of the plate, then click [OK].
Next, click [OK] to close the [Printer Setup] dialog
box.

Roland MODELA MDX-+ on COM1: Properties 2
Size | Toal I Dptmnsl
Engraving Ar,
Width -

Length

Type in the Text

Click , then click at the location where you want to type in text.

While in this state, type in the text with the keyboard.

2

4

Make sure [Roland MODELA MDX-20] is
specified as the printer, then click [Properties].
The [Roland MODELA MDX-20] dialog box
appears.

Print S etup 2l

Frinter ——

Hame: |{F!ﬂ|and MODELA MDR- e -| Broperties

Status: Ready
olah

Source; - Landscape

Cancel

The white portion of the screen is the engraving
area. Lay out shapes and text inside the area.

&Untitled - Dr.Engrave
Ele Edit Wiew Fomat Shape Lapout Help

D || oele| [y x|l Alojo|o]s]~|E

% Untitled - Di_Engrave
File Edit “iew Format Shape Lapout Help

ol|e(@]e] o=le| Iy xlal Alo|o|ols| -

ABGC
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Draw a Shape % Untitlod - Dr Engrave

File Edit “iew Fomat Shape Lapout Help

|-[=[x ala) 4lolo]ol#| )T

)
o

Click on the shape-drawing controls to draw the shapes. D | E'ﬂ| =

Change the Size and Location of a Shape or Text

Click El , then click the shape or text.

Solid square ([li]) and triangle ( A ) pointers appear around the shape or text. To change the size, drag the pointers.

<Changing the Size>

l Drag to change the vertical size.

You canfreely changethesizeofthe ___ g -
object by dragging. To retain the

object’s vertical/horizontal aspect

when you change its size, hold down

the [Shift] key while dragging. q

Drag to change the horizontal size.

<Rotating and Slanting>

Clicking again makes the pointers change to circles (@ ) and diamonds ( @ ).

Drag to rotate the shape. Drag the “ @” to slant the shape.
o= l /
/ o
<Moving the Location> = A =
To change the location, drag between q -

the pointers.
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Save the Data Save As

Click the _ Saven

The [Save Ag] dialog box appears.
File hame: |Urtitied E]

Enter the name of the file and click [Save].
Save as hype: |Dr.Engrave Document [* ded) j Caricel

4 Program

Start Engraving Print 20 x|

Frinter

Click the : Name:  [Fiolar MOGE L MOW. o =] Properties

The [Save Ag] dialog box appears.

Statug: Ready

To start engraving with MODELA, click [OK]. Type:  Faland MODELA MO x
Where:  COMI:
Comment; [ Print ta file
Frint range Copies
& Al MNurber of copies: 1 El:

- i
" Selection AIM iﬂ ilﬂ
[:l Cancel

Description of Controls

D This opens new file. This zooms the screen in or out.

This opens an existing file. Thistypesin the text

Tu
=
E This saves thefile, overwriting the previous data. This draws the shapes

oe
~

0 (=] |2

This sends engraving datato MODELA.

L
_
'y

This makes an entry frame for text.

This del etes the selected object and copiesit to the
clipboard.

e
=

This changes the chosen text string to line

This copies the selected object to the clipboard. characters,

by
-

This performs flat-drag machining for the interior

E‘ This copies the clipboard data to the screen. of a shape or text
. These change the context of an object.
This selects a shape or text.
x EE
Thisis used to reposition the vertices of a polygon, 123 L i These set the direction of thetext string.
,f';— changing its shape. — [I=
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3D Engrave

This adds thickness to a flat (two-dimensional) graphic to create arelief (raised engraving).

You can also add thickness to images such asillustrations.

3D Engraveis aprogram for creating reliefs (raised engravings) and engravings on curved surfaces.

This section describes the steps for cutting arelief.

For detailed descriptions of the creation steps and more information about creating data for engraving,

Select the Output Device

See"5 Instaling the Software - Program Settings' and choose the model you're using.

Decide on the Size of the Relief

From the [Relief] menu, click [Relief Size].
1 The [Relief Size] dialog box appears.

= Untitled - 3DEngrave
File Edt “iew Image Shape Relief Cut Help

Relief Size...

LCreate Relief...
Dielete Relief

Smoothing

The screen at right appears. The white area of the
3 screen is the where you design the relief.
The screen displayed at thistimeis called the "2D
screen.” It's the screen for typing in text and
creating shapes.

Enter the size of the relief and the resolution (the
2 degree of detail of therelief), then click [OK].

Relief Size x|

Size Horizontal |20 M |::|
Wertical (60 rAf Cancel
Rezalution (0.2 mm

Required
Memory 938 KBytesz

£: Untitled - 3DEngrave -|o] x|
Fle Edt View Imsge Shaps Belef Cut Help

Dcs{@] o (e[ ] av|v]u]
AlD|O[O]sz|2f [x i[5 [ Ae] Q=] [ [ =] Sle[= 1

Cuisor | 1347.17.8  Cantemaint Dimension | Angls Slart deg
Fieady 1005
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Creating Shapes and Entering Text

To create a shape, click one of the shape-drawing buttons and £ Unlitled - 3DEngrave (]|
drgg. File Edit Wiew Image Shape Felief Cut Help

To enter text, click the text-entry button, then click the locar e T e ) A A

tion where you want to insert text. While in this state, typein Alo|olo|x|a|Ix w5 [2]e] alaml =T o o] wle] = g
the text with the keyboard.

To change the size of a shape or text, refer to "Dr. Engrave -
Changing the Size and Location of Shapes and Text."

Cursor | 1347 178 Centerpoint Dimension mm | Angle Slant deg

Ready 100%

Create a Raised Engraving (Relief)

Add thickness to shapes and text to create arelief.

Click the shape or text string you want for adding
1 thickness to select it.

2 Ciicktne =l
The [Relief Size] dialog box appears.
The dialog box may differ depending on the type of object you selected. The following screen shows the dialog box that
appears when creating arelief of shapes or text.
Make the settings for the required items for creating the relief, then click [OK].

Create Relief il
ottom Shg;agchi [ = rik 1 Enter the height of the bottom of the relief.
felel B - _ Gancel | | Enger the thickness of the relief.
eight
iz s | oz M MM These choose the configuration for pushing the
Rid - |t . .
Diratior, 1P dee. O object up (or down)
l E "’-\'l _,_\_l 1 These choose how to stack the relief.
[ Smaothing I.‘. 0

|
These choose whether to push down or stack using
the value entered for the relief height.

Thisisfor entering the angle of the base side when

has been selected.

Thisisfor entering the direction of the relief ridge.
You can enter avalue when a button other that

[ 1] has been selected.

When thisis selected, the relief of the
chosen object is smoothed.
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3 The display changes automatically to the screen at 2 Untitlod - 30E ngrave =

right, and athree-dimensional view of the shape of Flo Fdl vow lnoge Shepe el G Heb
the relief appears. O|c|@| #|m|@| [ by |

Thisis called the "3D screen,” and it displays the [)8]&|wc| | [x 5i|S ||| Qlfo H[- - || Bla| =[i7

shape of therelief and the tool path. You cannot
edit shapes or text.

|

Cursor | 1387178 Centerpoint Dimension mm | Angls Slant deg
Feady 1005

Creating a Tool Path

A tool path is the path followed by the tool'stip. The tool path is generated from the cutting parameters that are presently set.
Beforeyou createthe tool path, make the settingsfor the cutting parameters. At the cutting parameters, make the settingsfor the composition
of the workpiece, the type of tool, and the cutting process.

From the [Cut] menu, click [Cutting Parameters].
1 The [Cutting Parameters| dialog box appears.
Make the settings for the necessary items for cutting, then click [OK].

Cutting Parameters x|
This chooses the composition of the workpiece. Material | Styrensfoam - oK |
) . M amirmLarm ’D— et
This sets the depth for cutting. Depth o
Process
This chooses the cultti Ng process. & Draft Cutting " Finishing [ar Engraving)
. e . Tool
Make the settings for the tool specifications. ?:pe
Tool Dia. |3 mm

" Square End Mil
¢ Ball End Mil Blade Width |0.32 mrm

Blade &ngle |24.2 deg.

Carving Conditions

Fath ey
Interval 112 nm Speed 15 mm/zec

E;To%:: |’3 mm 2 Speed |3 mmy/sec

Finish
o BT o
_ I .
Click the|=™ ] . When the tool path is created, £ Untitlod - IDEngrave =
2 i'[ appearsin plnk on the 3D screen. File Edit Wiew Image ﬁape Belief Cut Help
Dl=(a] [mle| = alulu]yl
|m| || x|a| v 5]§]218] alofs =[]
|

Cuisor | 1347.17.8  Cantemaint Dimension | Angls Slart deg
Fieady 1005
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Checking the Cutting Results

If Virtual MODELA isinstalled and set up, then before you perform actual cutting you can check the shape that will be produced after
cutting on the screen.

From the [File] menu, click [Output Preview]. The cutting data from 3D Engrave isimported into
1 Virtual MODELA starts. 2 Virtual MODELA.
An animated display of tool movement appears,
File Edit “iew |Image Shape RBelief Cut Help and the shape after cutting is gradually produced.
bz Egl ] W Untitled - Virtual MO
QDEH... Ctri+0 File  Simulate Wiew Option He .
o ——Fave — Qs | — |26 &|m[»|5] *  For more informa-
= ==, e T tion on how to
operate Virtual
Impert... MODELA, see the
Uutput Presiew help for Virtual
Output Device Setup... MODELA.

Save the Data

Click the . Save As
The [Save Ag] dialog box appears. Save i =4 1D Engrave
Enter the name of the file and click [Save]. )
__|Rsf
__1 Sprnbal
File hame: |Urtitled 3de [:l
Save as hpe: |3DEngrave File [7.3de) j Cancel
Start Engraving
S IF
Click the :H: . 3DEnerave x|
When the screen at right appears, click [OK].
Cutting with MODELA starts. ] 'r Start cutting.
L]

Cancel |
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Description of Controls

[

[

i

2D

I

This opens new file.

This opens an existing file.

This saves the file, overwriting the previous data.

This deletes the selected object and copiesit to the
clipboard.

This copies the selected object to the clipboard.

This copies the clipboard data to the screen.

This switchesto aflat (two-dimensional) shape-
editing screen.

This switches to a solid (three-dimensional) display
screen.

Display this screen when you want to check atool
path or the shape of arelief.

This adds thickness to shapes, text, images or other
flat objects to create arelief (raised engraving).

This creates atool path for engraving for the selected
shapes and text.

The tool path for engraving appears on the 3D screen
asared line.

This creates atool path for relief cutting.
The tool path for cutting appears on the 3D screen as
apink line.

This outputs the tool path to the MODELA and starts
cutting.

Thistypesin the text

L] |*=

U] O

This draws the shapes

A
~f

==l

'

This selects a shape or text.

Thisis used to reposition the vertices of a polygon,
changing its shape.

These are used to retouch
Qéf @ imported images.

= (o] e

This zooms the screen in or out.
The mouse operations for the 2D screen and the 3D
screen are different.

This changes the display location of the object.
This moves the screen display to show areas outside
the window which are not visible.

This changes the perspective of the relief when you
drag the screen.
Thisisavailable only during 3D screen.

This command expands or reduces the size of the
object shown to fill the screen.

These select the pen width for

* ® retouching an image.

[

[Jj]] These change the context of an object.

1=2=

S
Whim

These set the direction of the text string.
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10 What to Do If...

<The MODELA doesn't operate>

Is the STANDBY key on?
Pressthe STANDBY Kkey.

Has operation not been paused by pressing the VIEW key (lighting up the VIEW LED)?
Press the VIEW key to cancel the View state.

Are the cable connected correctly?
Check the output ports for MODELA and the computer and make sure they are connected correctly.

Is the cable for the connection with the computer suited to the MODELA and the computer?
- For the cable, use a optionally available seria cable (such as XY-RS-34). A straight serial cable such asis commonly used to connect
amodem cannot be used.

Are the settings for the computer and the software correct?
Check the following and make the correct settings.

Data output port : Port connected to any one of COM1 through COM4
Communication parameters  : Bit rate of 9,600, no parity, one data bit, stop bit 8, and hardware handshaking
Selected output device : MDX-15 or MDX-20

<Pressing the STANDBY key does not switch off the power.>

Unplug the AC adapter from the unit.

<The MODELING MODE LED or SCANNING LED Flashes Rapidly (Ten Times Per Second) >

Was the power switched on in the correct sequence?
First turn on the computer, then turn on MODELA.

This indicates a communications error.
Switch off the power, then check the cable connections and the port setting for the driver.

Was the computer restarted?
When the computer has been restarted, switch the power to the MODELA off, wait afew seconds, then switch it back on.

<All LEDs Flash Slowly (every 0.5 sec.) >

Has the cord come loose from the spindle unit or the sensor unit?
Switch off the power and reconnect the cords to the jacks.

<Errors During Cutting>

Speed drops during cutting

When cutting a workpiece of uneven hardness, such as wood, the MODELA may slow down automatically (to a minimum speed of 0.1
mm (0.00394 in.) /sec.). Oncethe MODELA has gone beyond the hard area, cutting continues at normal speed.

The STANDBY LED is flashing slowly (every 0.5 sec.)

The workpiece cannot be cut, even when the speed isreduced. Switch the power off and back on.
Make sure the cutting tool being used is appropriate for the hardness of the workpiece in use. Modify the software settings to cut the
workpiece alittle at atime.

65



Tool movement is different than the data

If an attempt is made to cut more deeply than the range of movement for the MODELA allows, the tool automatically risesto the
uppermost point.

Check to make sure that depth settings in the cutting data are not too deep, and that the tool extending from the spindle unit is not too
short.

Correct cutting is impossible

Are the cutting tool, spindle, and workpiece all installed and loaded securely?
Retighten the setting screw for the tool and the mounting screws for the spindle.

Unusual noise is heard from the spindle

The spindle unit is aconsumable part. Replace with a new spindle unit after 700 hours of use.

The spindle motor does not run

The spindle motor is aconsumable part. Replace with anew spindle motor after 700 hours of use.

The VIEW LED is flashing slowly (every 1 sec.)

Is the front cover detached?
Install the front cover.
When a sensor unit isinstalled, the VIEW LED does not flash.

<The SCANNING LEDs repeatedly flashes twice>

Something touched the sensor during initial operation immediately after switching on the power, or a hardware error oc-
curred.

If there is an obstruction, then switch off the power, remove the obstruction, and switch the power back on.

If there was a hardware error, then switch the power off and back on and repeat the same operation.

If the same error display occurs, consult your authorized Roland dealer or service center.

<Unexpected Program Operation>

I can't open afile.

Does the program you're using support the format of the file you're trying to open?
Check the program and the file format, and make sure the combination is supported.

There is not enough memory available for processing.

Close al other applications, or restart Computer.

If the file cannot be opened even after restarting the program, there may not be enough free space left on the hard disk.

If thisisthe case, free up space on the hard disk by deleting unneeded files or moving them to another disk.

If the messages about insufficient memory still appears after doing this, it is recommended that you increase the amount of memory in
your computer.

The included software doesn't function.

Does the computer you're using provide the correct operating environment for the included software?
Refer to the [Read Me] and check the operating environment, and use a computer that meets the operating-environment requirements.

Was the software installed using the setup program?
Be sure to use the setup program when installing the software.
The setup program puts the files for each software package in the necessary locations to enable the software to be used under Computer.

If an Error Message Appears

Refer to the help for the program you' re using.
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11 Items That May Not Be Copied

Unauthorized reproduction of a copyrighted item for any purpose other than personal use may be a violation of copyright. Roland DG
Corp. will not be responsible for any violation of third-party copyright by any article made through use of this product.
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12 Specifications

Main Unit Specifications

XY table size
Max. operation area

Max. table load weight
Interface

Control keys

LED

Power consumption
Acoustic noise level

External dimensions

Weight (unit only)
Operation temperature
Operation humidity
Accessories

MDX-20
220 mm (X) x 160 mm (Y) (8-5/8in. x 6-1/4in.)
203.2 mm (X) x 152.4 mm (Y) x 60.5 mm (Z)
@Bin. (X)x6in. (Y)x2-3/8in. (2))
1000g(2.21b.)
Seria (RS-232C)
STANDBY key, VIEW key, TOOL-UP key, TOOL-DOWN key,
SCANNING MODE LED, MODELING MODE LED, VIEW LED
Exclusive AC adapter (DC+19V 2.1 A)
Standby mode :under 35 dB (A)
Operation mode (not cutting)  : under 70 dB (A) (According to 1SO 7779)
476.8 mm (W) x 381.6 mm (D) x 305 mm (H) 426 mm (W) x 280 mm (D) x 305 mm (H)
(18-13/16in. (W) x 15-1/16 in. (D) x 12-1/16 in. (H)) (16-13/16in. (W) x 11-1/16 in. (D) x 12-1/16in. (H))
13.7kg (30.21b.) 9.6kg (21.21b.)
5t040°C (41to 104°F)
351080 % (no condensation)
AC adapter: 1, power code: 1, Roland Software Package CD-ROM: 1, spindle unit: 1, sensor unit: 1, cap
screw M4x15: 4, tool:1, set screw M3x3: 2, double-sided tape: 1, front cover: 1, hexagonal wrench (size:
3 mm) :1, hexagona wrench (size : 1.5 mm): 1 positioning pins: 3, clay: 1, MDX-20/15 user's manual: 1

MDX-15
170 mm (X) x 120 mm (Y) (6-11/16in. x 4-5/16in.)
152.4 mm (X) x 101.6 mm (Y) x 60.5 mm (2)
©®in. (X)x4in. (Y)x 2-3/8in. (2))
5009 (1.11b.)

Modeling Functions

Tool chuck

Spindle motor
Software resolution
Mechanical resolution
Revolution speed
Feed rate

Acceptable material

Acceptable tool

: 6 mmor /8 in. tool chuck included

: 10W (DC motor)

: 0.025 mm/step (0.000984 in./step)

- 0.00625 mm/step (0.000246 in./step)

: 6500 rpm

: 0.1 to 15 mm/sec. (0.00393 to 9/16 in./sec.)

- Wood, Plaster, Resin (modeling wax, styrenform), Chemical wood, Aluminum (A5052 according to JIS),

Brass

: Endmill, Drill

Scanning Functions

Sensor

Scanning method
Scanning pitch
(Dr. PICZA)
Scanning speed

: Roland Active Piezo Sensor (R.A.P.S))

Probe length 60 mm (2-5/16 in.), tip bulb diameter 0.08 mm (0.00315 in.)

. Contacting, mesh-point height-sensing
: X/Y-axis directions -- 0.05 to 5.00 mm (0.002 to 0.20 in.) (settable in steps of 0.05 mm (0.002 in.))

Z-axisdirection -- 0.025 mm (0.000984 in.)

: 4to 15 mm/sec. (1/81t0 9/16in./sec.)

Interface Specification

[Serial]

Standard
Transmission method
Transmission speed
Parity Check

Data Bits

Stop Bits

Handshake

1 RS-232C specifications

: Asynchronous, duplex data transmission
: 9600 bps

- None

: 8 hits

. 1bits

. Hardware
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Serial connector (RS-232C)

Signal Terminal Signal ) .
number number number Pin connection
NC 25 13 NC
NC 24 12 NC
NC 23 11 NC
NC 22 10 NC
NC 21 9 NC
DTR 20 8 NC ®000000000000
Ne |10 | 7 <
NC 18 6 DSR
NC 17 5 CTS
NC 16 4 RTS
NC 15 3 RXD
NC 14 2 TXD
1 FG
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Please read this agreement carefully before opening the sealed
package or the sealed disk package

Opening the sealed package or sealed disk package impliesyour acceptance of the terms and conditions of this agreement.

Roland License Agreement

Roland DG Corporation ("Roland") grants you a non-assignable and non-exclusive right to use the COMPUTER
PROGRAMS in this package (" Software") under this agreement with the following terms and conditions.

1. Coming into Force Thisagreement comesinto force when you purchase and open the seal ed package
or sealed disk package.
Theeffective date of thisagreement isthe date when you open the seal ed package
or sealed disk package.

2. Property Copyright and property of this Software, logo, name, manual and al literature

for this Software belong to Roland and its licenser.

The followings are prohibited :

(1) Unauthorized copying the Software or any of itssupport file, program module
or literature.

(2) Reverse engineering, disassembling, decompiling or any other attempt to
discover the source code of the Software.

3. Bounds of License Roland does not grant you to sub-license, rent, assign or transfer the right granted
under this agreement nor the Software itself (including the accompanying items)
to any third party.

You may not provide use of the Software through time-sharing service and/or
network system to any third party who is not individually licensed to use this
Software.

You may use the Software by one person with using a single computer in which
the Software isinstalled.

4. Reproduction You may make one copy of the Software only for back-up purpose. The property
of the copied Software belongs to Roland.
You may install the Software into the hard disk of a single computer.

5. Cancellation Roland retains the right to terminate this agreement without notice immediately
when any of followings occurs :
(1) When you violate any article of this agreement.
(2) When you make any serious breach of faith regarding this agreement.

6. Limitations on Liability Roland may change the specifications of this Software or its material without
notice.

Roland shall not be liable for any damage that may caused by the use of the
Software or by exercise of the right licensed by this agreement.

7. Governing Law This agreement is governed by the laws of Japan, and the parties shall submit to
the exclusive jurisdiction of the Japanese Court.
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